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Introduction

What’s In It for Me?

The Flicware Pro application is a state-of-the-art
software wedge for your Flic bar code scanner.
The Flicware Pro program can do anything that
Flicware software can do, and much, much more:

With Flicware Pro software, you can:

• Create multiple transactions of several fields
each.

• Add keystrokes to data scanned to navigate the
application, or to supply data in the form that your application wants.

• Create custom voice prompts and error messages to keep the user informed of the
transaction’s progress.

• Assign a transaction to a specific application window, so that the transaction automati-
cally activates when that window is brought to the front.

Together, the Flicware Pro software and your Flic scanner are an intelligent wedge sys-
tem that automatically detects the recipient application and changes its behavior to
meet that application’s needs. No hardware wedge can do this alone. an added advan-
tage of Flicware Pro software over the Flicware program is that if the Flicware Pro soft-
ware isn't running and you plug the scanner in, the data remain in memory.

Technical Support

For technical support, please contact your vendor.

Technical support for Flicware Pro software is also available on our website at 
www.flicscanner.com.
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Installation
Flicware Pro software is available for download at www.flicscanner.com. If you prefer,
you can purchase it on CD for a small additional charge.

Software Installation

To download and install the program, visit www.flicscanner.com and click on the link for
"Flicware Pro." Follow the on-screen instructions to purchase your licensed copy of
Flicware Pro software.

To install the program from CD, place the disk in your CD drive and follow the instruc-
tions. If your CD drive does not support the autorun feature, open the CD file and
double-click on the setup.exe program icon.

By default, the drive and directory where the Flicware Pro application installs itself is
c:\Program Files\Flicware Pro. You may specify a new location by pressing the Change
button in the installation dialog box. Then follow the directions given by the installation
program to completely install your Flicware Pro software. It shouldn’t take more than a
few minutes of your time.

Hardware Installation

All you have to do to install your hardware is to connect the Flic scanner cable to the
RS-232 port on your computer, and plug the cable into your Flic scanner.

We offer many accessories for your Flic scanner to support portable or tethered appli-
cations, including a convenient holster, docking station, USB adapter cable and protective
boot.

Flic Scanner Configuration

The first time you launch the Flicware Pro application, you will be asked to configure
your Flic scanner (see page C.5). Every new scanner must go through this configuration
process; if you do not configure your Flic scanner prior to use, you will receive an error
message that says your Flic scanner is not configured.
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Installation 

License

Your use of Flicware Pro software is conditional upon your acceptance of the terms of
Microvision’s end user license agreement which will be displayed prior to your first use
of the Flicware Pro software. If you do not agree to the terms of the end user license
agreement, you will not be able to use the Flicware Pro software. The terms of the
end-user license agreement are reproduced at the end of this manual.
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Demo: Create a Wedge
This section teaches you how to create a simple wedge with audio prompts using
Flicware Pro software’s powerful Transaction Definition tools. This simple wedge transac-
tion takes whatever data you scan and puts it into Notepad just as if you’d typed the
data in at the keyboard.

To Begin

Start Notepad (typically done by pressing Start / Programs / Accessories / Notepad)
and the Flicware Pro application. Configure your Flic scanner, if necessary (see page
C.5).

Within Flicware Pro software, select New Transaction from the Transaction menu. The
top text box in the dialog is labeled Transaction Name; enter Notepad Demo in the
text box.

The second text box from the top is labeled Window Title. It has a drop-down menu
that shows the titles of all windows currently open on your computer; click on the
arrow and select “Untitled - Notepad” from the available options.

Press the Transaction Prompt button and select NOTEPAD.WAV for the transaction
prompt two rows below where you selected the window title. This WAV file will play
whenever Notepad is brought to the front, indicating to the user that this transaction is
now active.

Next, near the bottom, notice that the text box next to the Audio Prompt button
shows FIELD.WAV. This audio prompt tells the user to scan the first (and only) field in this
demo. You can leave this and all the other defaults in place at this time.

Click OK to close the Transaction Definition window.

Now click on the Tools menu and select Options. Select the System Settings tab and
press the Transaction Complete button. Choose the file TRANDONE.WAV; this will play
whenever Flicware Pro software completes a transaction.

Press the OK button to close the dialog.
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Demo: Create a Wedge

Testing the Demo

Under the Tools menu, click to place a checkmark next to Active. This tells Flicware Pro
software that you are ready to begin. The Flicware Pro application’s title bar now reads
“Flicware Pro (active).”

Next, click on the Notepad window. When you do this, you’ll hear NOTEPAD.WAV say,
“Notepad, Untitled.”

Then FIELD.WAV, the audio prompt for Field 1 (the only field you have), plays, saying, “Scan
next bar code.”
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Demo: Create a Wedge 
Scan the following bar code:

*P102675*
P102675

When the scan is completed, so is the transaction, as Flicware Pro software expects only
a single field. Now that the transaction is complete, the file TRANDONE.WAV plays, saying,
“Transaction complete.”This is followed by “Scan next bar code,” the audio prompt for
Field 1 of the next transaction.

Next, scan this bar code:

*54-2*
54-2

At this time, your Notepad window
should look like this:

Notice that Flicware Pro software accepts any data from the scanner. Instructions for
how to filter for desired data in the next demo.
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Demo: Custom Transactions
This section teaches you how to create a custom transaction to capture part numbers
and quantities. This transaction also has audio prompts. This demo gives a simple illus-
tration of Flicware Pro software’s capabilities.

To Begin

Start WordPad (Start / Programs / Accessories / WordPad) and Flicware Pro software.

Within the Flicware Pro application, select New Transaction… from the Transaction
menu.

Name this transaction “Inventory Demo,” and select the “Document - WordPad” win-
dow from the drop-down menu (using the menu is far easier and more accurate than
typing the name of a window). Choose WORDPAD.WAV for the transaction prompt.

Finally, you may want to put some headers into our data file, so anyone who opens it
knows what all the numbers mean. Type: “Part #: ” into the Initial Keystrokes area (note
the space after the colon).

First Field: Part Number

The first data to scan for this demo will be the part number. Change the name from
“Field 1” to “Part #”.

For purposes of this demo, assume part numbers all start with P, but may have a variable
number of digits or letters following. Therefore, you should enter a field mask of P~? as
this will accept any string that starts with the letter P (see page C.14 for more on
masks). Since it is desired to have the part number and quantity be on the same line,
change the Exit Keystroke to “{TAB}QTY: ” (again, note the extra space after the colon).

Because you can have custom audio prompts, choose PN.WAV and BADPN.WAV for your
Audio Prompt and Error Sound, respectively.
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Demo: Custom Transactions 
Your Transaction Definition window should now look like this:

Second Field: Quantity

Press the New key to create a second field for the transaction. The area label changes
to say, “Field 2 of 2.”

Change the name from “Field 2” to “Quantity”. Since you may have no idea how large
the quantity field may be, enter a  have no idea how large the quantity field may be,
we’ll enter a field mask of ~# (see page C.14 for more on masks). Since we want only
one set of data per line, let’s leave the Exit Keystroke as “{ENTER}”.

Choose QTY.WAV and BADQTY.WAV for your Audio Prompt and Error Sound.

Do not change the initial keystrokes at this time.
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Demo: Custom Transactions 
Your Transaction Definition window should now look like this:

Now click the OK button to close the Transaction Definition window.

Once you’ve closed the Transaction, click on
the Transaction menu again. You’ll notice that
your Transaction menu now has the new
transaction included, as shown.
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Demo: Custom Transactions 

Testing the Demo

Now click on the Tools menu and click to place a checkmark next to Active.

Then click on the WordPad document. When you do this, you’ll hear WORDPAD.WAV

say, “WordPad transaction.”

Then the audio prompt for Part # plays, “Please enter part number.”

Scan the following bar code for part number:

*P102675*
P102675

The part number is entered in the WordPad window, followed by the audio prompt,
“Please enter quantity.” Now scan this bar code to enter the quantity:

*50*
50

Flicware Pro software enters the data, plays the WAV file for a completed transaction,
and prepares for a new transaction.

Now scan in a second part number and quantity:

*P186567*
P186567
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Demo: Custom Transactions 

*100*
100

Now test how Flicware Pro software handles errors. Scan the Part Number bar code
below, and the invalid quantity bar code following:

*P277657*
P277657

*54-2*
54-2

Flicware Pro software says, “Invalid quantity.” It
won’t accept the scan, as it doesn’t pass the
mask. Instead, scan the “100” bar code at the
top of this page again.

That’s all there is to it! 

Your window should now look like this:

Now that you’ve seen the power of Flicware Pro software, be sure to read the
Reference section, presented on the following pages.
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The Basics
Be sure to read the Flic scanner Operator’s Guide (included with the scanner) for tips
on using the hardware.

What Flicware Pro Software Does

Flicware Pro software is designed to work with a Flic bar code scanner connected to a
serial port on a PC running on most versions of Windows 95 or later. It also works
with a USB adapter cable, available for purchase from your vendor or at www.flicscan-
ner.com.

When Flicware Pro software is active, it sends ASCII data received from the serial port
(or USB port) to your Windows application as keystrokes. This means that everything
you scan enters the program just as if you typed it at the keyboard.

You can customize transactions for your Flic scanner for up to ten different programs.
The default configuration works just like the basic Flicware program, with even more
powerful options for modifying the incoming scan and testing it to ensure it’s the right
data.

Getting Started

The very first time you launch the
Flicware Pro application, it automat-
ically opens the Tools / Options
window for you, so that you can
test the Flic scanner’s connection
and configure your Flic scanner for
use with the Flicware Pro software.

When this window launches, you’ll
notice that the message area of the
Options window says, “Status:
Waiting for user input.”
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The Basics
Ensure that the Flic scanner is attached to its cable, and that the cable is attached to an
RS-232 port on your computer.

If you are using a USB adapter
cable, follow the instructions in
the USB Adapter Installation
Guide to install the necessary
driver. Connect the Flic scanner
using the USB cable.

Select the port’s ID, and press
the Configure button.

If everything is in order, the 
window will display the 
message, “Flic configured.”
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If, after pressing the Test button,
the status line says, “Flic not
detected,” check the connections,
and/or try another port.

Once the test is successful and
the Flic scanner is detected,
click OK to close the Options
window. The program’s main 
window launches, and you can
proceed.

Each new Flic scanner to be used
with the Flicware Pro software
must be configured, otherwise
they will not work properly.



Note that when you minimize the Flicware Pro software
window, it goes into the system tray instead of the task
bar like most programs. The system tray is that box at the
right-hand side of the task bar, where you can see the time display.

If a Flic scanner has not been detected, or if the Flicware
Pro application has not been made active (page C.9),
the system tray icon changes to remind you, as shown.

Tool Tips

If you hold your mouse still over any of your Flicware Pro software’s buttons or menu
items, a helpful hint appears. These “tool tips” can help you learn the program more
quickly; please take advantage of them.

The Basics

The Main Window

The Flicware Pro application is controlled by the
File and Tools menus in the main window. These
menu options are explained on the following
pages.
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The File Menu

Quit

This selection quits the Flicware Pro application. Depending on which preferences that
you have set (see page C.6), a dialog box may appear asking you to confirm that you
wish to quit.

About...

This selection provides information about Flicware Pro software and Microvision, Inc.
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The Tools Menu

Options...

The Options... window lets you choose the settings that control how your Flicware Pro
software operates. The function of each of the three tabs is described below.

Pressing OK saves your settings and exits the Options... dialog. Pressing Cancel exits
this dialog box without saving the changes you just made to the settings.

Options / Flic Configuration:

When the Flic Configuration tab is selected, you can confirm the port number assigned
to the Flic scanner, and test to ensure your connection is working.

Flicware Pro software can read from COM1 through COM16, as set by the drop-down
menu at the top.

Pressing the Configure button checks to ensure the Flic scanner is connected to that
port, and that it is properly configured.

If the Flic scanner is not detect-
ed, check the cable connec-
tions. If the cable is connected
properly, try selecting other
ports.

Each new Flic scanner to be
used with the Flicware Pro
software must be configured,
otherwise they will not work
properly.
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The Tools Menu

Options / Program Control:

When the Program Control tab
is selected, you can change the
basic way the Flicware Pro pro-
gram operates.

Confirmation Needed to Quit

This selection can provide a
measure of safety that ensures
you do not accidentally quit the
Flicware Pro application. You can
specify three different levels of
safety.

Always Confirm:When you check the Always Confirm radio button, Flicware Pro soft-
ware will always double-check that you want to quit when the program is operational,
whether or not Flicware Pro software is active.

Confirm When Active:When you check the Confirm When Active radio button, the
Flicware Pro software will only ask you for confirmation if it is currently selected to be
active (and is therefore probably processing bar codes).

Never Confirm:When you check the Never Confirm radio button, the Flicware Pro
application will never ask you to confirm that you want to quit; it will exit the program.

Active on Start-Up (Recommended)

When you check the Active on Start-up check box, Flicware Pro software immediately
becomes active when you start the Flicware Pro program. This is useful if you want to
automatically load and start the Flicware Pro application and start scanning bar codes
immediately when the computer boots. To have Flicware Pro software start automati-
cally, you must have a shortcut to the Flicware Pro software in your Startup directory 
(typically My Computer / C: / Windows / Start Menu / Programs / StartUp). See your
Windows help tool or manual for more details.
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The Tools Menu

Options / System Settings:

This window lets you control
the audio feedback provided
for two important events: an
error trying to link to the 
application window, and a 
completed transaction.

The Invalid Window button lets
you browse for and select a
WAV file to be played if the
front window title does not
match any transaction currently
configured (see below). This
serves as a reminder to the
user to make the desired appli-
cation or document available.

Note: Unless the Simple Wedge transaction is deleted, the Invalid Window message will
never be activated. When you click on a window to make it the front window, the
Flicware Pro software compares the window’s title to the defined transactions, starting
from the top of the Transaction menu list and working to the bottom. The Simple
Wedge transaction (see page C.11) accepts any window, as it has ~? in its window title
field. Thus, you can only have an invalid window error if Simple Wedge is no longer at
the bottom of the Transaction menu.

Finally, the Transaction Complete button lets you choose a WAV file to be played at the
successful completion of any transaction. This confirms to the user that the transaction
was successfully transmitted, and can act as a prompt for another transaction.
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The Tools Menu

Trace...

Debugging may be required to
properly configure Flicware Pro
software for your application.
This dialog box allows you to see
exactly what data your Flic reader
is sending to your computer.

Seeing this data can help you
determine whether or not you
need to strip characters and/or
append characters in the format
window to get your data
processed properly. If the bar
code symbols you scan include
data identifiers or application identifiers but your application doesn’t use them, you may
want to set up Flicware Pro software to strip these unused characters.

Note: The Flicware Pro application automatically strips <STX> and <ETX> characters.

Pressing the OK button closes this window.

Display Input Using...

This lets you choose whether you wish to see ASCII characters in hexadecimal format,
or the names of the characters.

When Character Names is selected, non-printable ASCII characters are displayed with
abbreviations contained between brackets. For example, in the above diagram, the last
character <ETX>, stands for “end transmission.”

Input from com Port

This text box shows you precisely what data are being sent. Newer transmissions are
added to the end of the text shown.
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The Tools Menu

Active

This menu option is a yes/no selection; it does
not open a dialog box.

When Active is checked, the Flicware Pro 
application is ready to accept data from the Flic
scanner and insert it into your Windows applica-
tion. When Active is not checked, Flicware Pro
software is disabled and data from the Flic laser
scanner will not be processed.

Active must be unchecked to change the Options and Transaction settings.

You cannot check Active if a Flic scanner has not yet been configured.

Flicware Pro User Manual www.flicscanner.com Page C.9
DA0108117-002 Rev A



The Tools Menu 

Register Flicware Pro…

In this window, you can activate your license.

When you purchase Flicware Pro software online, a unique serial number is provided
both on the screen and included in a separate email sent to you.

If you purchased Flicware Pro software on a CD, the serial number is provided on the
CD sleeve.

To register your program and unlock its capabilities, enter the serial number provided by
Microvision along with your registration information. Be sure to save this serial number
as proof of your purchase.
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The Transaction Menu
All data processing is defined using transactions. A transaction is a set of instructions
that details what scanned data to expect and how to handle that data. To use a transac-
tion, it must be defined prior to setting the Flic scanner to Active.

If you have multiple transactions, the Flicware program checks to see if the currently
active window matches any of the defined transactions (from top to bottom). It then
uses the first transaction that matches. Since the Simple Wedge transaction matches any
window, and since it is always the bottom transaction, it is always used as a last resort.

Simple Wedge...

Simple Wedge is a default transaction setting. It acts just like the basic Flicware program:
a no-frills wedge. All characters scanned are sent as keystrokes to whichever application
is the current window.

[Custom] Transaction...

Flicware Pro software allows you to create cus-
tomized transaction processes, defining how they
interface with different application windows. As
you do so, new menu items appear in this menu,
labeled with the names of your transactions.

Selecting one of these menu items opens the
Transaction Definition window, allowing you to
edit or delete the transaction.

New Transaction...

Selecting this item opens the Transaction Definition window (see page C.12) and creates
a new transaction within it. This transaction will appear at the top of the Transaction
menu. Flicware Pro software allows you to create up to ten custom transactions, allow-
ing your Flic scanner to interact with up to ten separate application windows.

Transaction definition is described in the next section.
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Transaction Definition
When you open a transaction, the following window appears. This transaction definition
window allows you to define every aspect of the transaction, customizing it for your
application, file, and data source.

This top section
contains the
Transaction
Controls, which let
you let you define
global parameters
for the transaction.

This boxed area
contains the Field
Controls, which let
you adjust the
order and type of
data to be scanned
for each field in the
transaction. You
can have as many
fields as you like
for a transaction,
and configure each
one separately.

Pressing the OK button at the bottom accepts the transaction with the changes you
made. Pressing Delete Transaction erases the transaction and takes you back to the
main window.

Transaction Controls

Transaction Name

This is the name you wish to give the transaction. This name will appear in the
Transaction Menu as a selection.
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Transaction Definition 
Window Title

This field holds the name of the application window to which the scanned data is sent.
as keystrokes. You may either enter it by hand, or select it from a drop-down list. This
list contains the names of all the windows that are currently open on your PC.

Note that many applications include document names in their window titles. This allows
you to define transactions for different documents in that application.

Initial Keystrokes

If you have any keystrokes you want performed before beginning each transaction (for
example, tabbing to the appropriate field), you may enter them here. These keystrokes
will be executed before the first field is keyed into the application for the transaction.

Enter printable characters without modification. Non-printable characters must be
enclosed in braces, for example {TAB} and {ENTER}. For a complete list of non-print-
able character translations, see page C.16.

Transaction Prompt

You may select an audio prompt (stored as a WAV file) to play at the start of the trans-
action. For example, you may want to record a prompt that says, “Inventory, ready to
receive.”

A number of audio prompts are included with your Flicware Pro application. These are
accessible in the Sounds subfolder of your Flicware Pro folder (by default, this is My
Computer \ C: \ Program Files \ Flicware Pro \ Sounds).

Field Controls

Everything in this boxed area edits the individual fields for a transaction. The label at the
top left corner of the box shows you which field of the transaction you are working on.
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Transaction Definition 
Field Name

This is simply a label to remind you what the data represent in the field you are editing.

Field Mask

With the field mask, you can have Flicware Pro software check incoming data to ensure
that the proper bar codes are being scanned. Flicware Pro software checks the data
being sent (before exit keystrokes are added), and compares data against the mask. The
data must fit the mask completely. Certain characters have special meaning:

@ This character matches upper- and lower-case a-z only.
# This character matches the numeric digits from 0-9.
? This character accepts any printable character.
~ This is a prefix that indicates that any quantity of the following characters is

acceptable (even zero).

All other characters in the mask are treated literally. So, for example, let’s assume you
want to make sure that the user scans a part number for a given field and all your part
numbers begin with “PA” and follow with one or more digits. If you set your field mask
to “PA”, only scans that are exactly “PA” will be accepted. If you set your field mask to
“PA~?”, any scan that starts with PA will be accepted, whether it’s “PAllowed” or “PA7”.

However, you might want to ensure that the user scans a bar code with at least one
digit following the “PA”. Use “PA#~#”, and Flicware Pro software will ensure that at
least one digit follows the PA. It may seem that you could use the mask “PA~##”, but
this will not work. Flicware Pro software scans the field mask from left to right. The
application will compare the P and A, then use all the remaining digits to fill the ~# part
of the mask. That leaves nothing left over for the final # character in the mask, and the
comparison would always fail.
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Transaction Definition 
Exit Keystrokes

These keystrokes are added after the scan has been converted into keystrokes. You may
wish to use these to navigate the application window before entering the next scan.

Non-printable characters must be enclosed in braces, as in {TAB}. A full list is presented
on page C.16.

Audio Prompt

This sound plays when Flicware Pro software is ready for the field to be scanned.

Error Sound

This sound plays when the scanned data do not match the Field Mask.

Chars to Strip

These two options let you set how many characters to strip from the front and/or back
of the scanned data. Characters are stripped after the scan is compared to the mask,
but before any exit keystrokes are added.

The Buttons

The Previous and Next buttons navigate you through the various fields available for this
transaction. The New button creates a new field at the end of the set of fields, while
the Delete button deletes the field you are currently editing.

Finally, OK accepts all changes, while Delete Transaction removes the transaction from
the menu selections.
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Translating Non-Printable Characters

This list gives you the translations for each non-printable character for use in the Initial
Keystrokes and Exit Keystrokes fields.
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Key Translation
+ {+}
^ {^}
% {%}
~ {~}
{ {{}
} {}}
[ {[}
] {]}
↓ {DOWN}
← {LEFT}
→ {RIGHT}
↑ {UP}
Backspace {BS}
Break {BREAK}
Caps Lock {CAPSLOCK}
Carriage Return {ENTER}
Del {DEL}
End {END}
Enter {ENTER}
Esc {ESC}
Help {HELP}
Home {HOME}
Insert {INSERT}

Key Translation
Num Lock {NUMLOCK}
Page Down {PGDN}
Page Up {PGUP}
Print Screen {PRTSC}
Scroll Lock {SCROLLLOCK}
Tab {TAB}
F1 {F1}
F2 {F2}
F3 {F3}
F4 {F4}
F5 {F5}
F6 {F6}
F7 {F7}
F8 {F8}
F9 {F9}
F10 {F10}
F11 {F11}
F12 {F12}
F13 {F13}
F14 {F14}
F15 {F15}
F16 {F16}



Flicware License Agreement
FLICWARE™ AND FLICWARE PRO™

END USER SOFTWARE LICENSE AGREEMENT

IMPORTANT NOTICE TO END USERS: This End User
License Agreement (the “Agreement”) is a legal agreement
between the purchaser of the Licensed Software being made avail-
able for use with the Microvision Flic™ bar code scanner (either an
individual person or a single legal entity, who will be referred to in
this Agreement as “You”) and Microvision, Inc.

BY DOWNLOADING, INSTALLING, COPYING OR OTHER-
WISE USING THE LICENSED SOFTWARE (AS DEFINED
BELOW), YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE
TERMS OF THIS AGREEMENT, DO NOT DOWNLOAD,
INSTALL, COPY OR USE THE LICENSED SOFTWARE.  IF
YOU ACQUIRED THE LICENSED SOFTWARE ON TANGI-
BLE MEDIA (e.g.  CD) WITHOUT AN OPPORTUNITY TO
REVIEW THIS LICENSE AND YOU DO NOT ACCEPT THIS
AGREEMENT, YOU MAY OBTAIN A REFUND OF ANY
AMOUNT YOU ORIGINALLY PAID IF YOU (A) DO NOT USE
THE LICENSED SOFTWARE AND (B) RETURN IT, WITH
PROOF OF PAYMENT, TO THE LOCATION FROM WHICH IT
WAS OBTAINED WITHIN THIRTY (30) DAYS OF THE PUR-
CHASE DATE.

This Agreement is effective on the date on which You manifest
Your acceptance of this Agreement by downloading, installing,
copying or otherwise using the Licensed Software.

IMPORTANT NOTICE TO RESELLERS AND DISTRIBU-
TORS:  If you are an authorized reseller or distributor of the
Microvision Flic™ bar code scanner, you may download the
Licensed Software for distribution or resale to end user customers,
provided that doing so is consistent with the terms of your existing
distribution or reseller agreement with Microvision.  Except as pro-
vided in the following sentence, your acceptance of the terms of
this Agreement will not supercede, modify or amend the terms and
conditions of your existing reseller or distributor agreement with
Microvision.  However, by downloading the Licensed Software and
manifesting your acceptance of this Agreement, you agree that (i)
you will only distribute the Licensed Software pursuant to this End
User License Agreement between Microvision and the end user; (ii)
you will provide each of your end user customers with a copy of
this End User License Agreement and ensure that such end users
are on notice that their use of the Licensed Software is contingent
upon their acceptance of the terms and conditions of this End User
License Agreement, and (iii) you will refund the purchase price of
the Licensed Software to any end user customer who does not
accept the terms and conditions of this End User License
Agreement and returns the Licensed Software unused within thirty
(30) days of their purchase date.
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DEFINITIONS.  In this Agreement, “Licensed Software” means
the computer programs, in machine-readable, interpreted, compiled
or other form, furnished to You for use with Flic™ Scanner(s),
whether owned or licensed by Microvision, and including without
limitation, (i) computer programs residing on any medium and all
materials or contained in any download supplied by Microvision in
connection with the Licensed Software, (ii) related explanatory
written materials or files (“Documentation”); and (b) upgrades,
modified versions, updates, additions, and copies of the Licensed
Software, if any, provided to You by Microvision, either directly or
indirectly (collectively, “Updates”).  The “Flic™ Scanner(s)”
means the Microvision Flic bar code scanner(s) that Microvision
sold to You, either directly or indirectly.  “Microvision” means
Microvision, Inc., 19910 North Creek Parkway, Bothell, WA
98011-3008.

LICENSE.  As long as You comply with the terms of this
Agreement, Microvision grants You a personal, non-exclusive,
non-transferable license to use the Licensed Software (in object
code form only) for Your own use in the operation of the Flic™
Scanner(s).  The license granted hereunder is perpetual.

SOFTWARE TITLE.  Microvision is not selling You the
Licensed Software.  Title to the Licensed Software, including all
translations, compilations, derivative works and copies remain
with Microvision or its licensors, as the case may be.

SUPPORT SERVICES.  Microvision or the reseller or distributor
from whom You purchased Your Flic™ Scanner(s) may provide
You with support services related to the Licensed Software
(“Support Services”).  Use of Support Services is governed by the
policies and programs described in the user manual, in “online”
documentation, or in other materials from the support services
provider.  Any supplemental software code provided to You as part
of the Support Services are considered part of the Licensed
Software and subject to the terms and conditions of this
Agreement.  You acknowledge and agree that Microvision and its
licensors, contractors, resellers and distributors may use technical
information You provide to them as part of the Support Services for
its business purposes, including for product support and develop-
ment.

RESTRICTIONS.  

You will not use the Licensed Software in conjunction with any
other equipment, system, processing units, or for any purpose other
than for the operation of the Flic™ Scanner(s) and solely for Your
internal business in accordance with operating instructions
Microvision or its authorized resellers or distributors may provide
from time to time.



Flicware License Agreement 

Flicware Pro User Manual www.flicscanner.com Page D.2
DA0108117-002 Rev A

Unless specifically and expressly permitted by Microvision, You
agree not to modify, adapt or translate the Licensed Software.  You
also agree not to reverse engineer, decompile, disassemble or oth-
erwise attempt to discover the source code of the Licensed
Software except to the extent You may be expressly permitted to
decompile under applicable law, it is essential to do so in order to
achieve operability of the Licensed Software with another software
program, and You have first requested Microvision to provide the
information necessary to achieve such operability and Microvision
has not made such information available.  Microvision has the right
to impose reasonable conditions and to request a reasonable fee
before providing such information.  Any information supplied by
Microvision or obtained by You, as permitted hereunder, may only
be used by You for the purpose described herein and may not be
disclosed to any third party or used to create any software which is
substantially similar to the expression of the Licensed Software.

INTELLECTUAL PROPERTY AND CONFIDENTIALITY.

The Licensed Software and any copies that You are authorized by
Microvision to make are the intellectual property of and are owned
by Microvision, Inc.  and its licensors.  The Licensed Software is
protected by copyright, including without limitation by United
States Copyright Law, international treaty provisions and applica-
ble laws in the country in which it is being used.  You may not copy
the Licensed Software, except as set forth in Section 2 (License).
Any copies that You are permitted to make pursuant to this
Agreement must contain the same copyright and other proprietary
notices that appear on or in the Licensed Software.  Trademarks
shall be used in accordance with accepted trademark practice,
including identification of trademarks owners’ names.  Trademarks
can only be used to identify printed output produced by the
Licensed Software and such use of any trademark does not give
You any rights of ownership in that trademark.  Except as express-
ly stated herein, this Agreement does not grant You any intellectu-
al property rights in the Licensed Software and all rights not
expressly granted herein are reserved by Microvision.

The Licensed Software, including without limitation its structure,
organization and code, and its accompanying Documentation are
Microvision’s or its licensors’, as the case may be, confidential
information and constitute trade secrets.  You will not directly or
indirectly, disclose such information except to those of its employ-
ees or consultants who require such disclosure in connection with
Your use of Flic™ Scanner(s) and who are also subject  to the same
confidentiality obligations.

LIMITED WARRANTY

Limited Warranty.  Microvision warrants that the Licensed
Software will perform substantially in accordance with the accom-
panying materials and online documentation for a period of ninety
(90) days from the date of receipt.  Any supplements or updates to

the Licensed Software provided to You after the expiration of nine-
ty (90) days limited warranty period are not covered by any war-
ranty or condition, express or implied.  Microvision and its licen-
sors and suppliers’ entire liability and Your exclusive remedy will
be, at Microvison’s option, (a) return of the price paid (if any) for
the Licensed Software, or (b) repair or replacement of the Licensed
Software that does not meet this limited warranty and that is
returned to Microvision.  This Limited Warranty is void if failure
of the Licensed Software has resulted from accident, abuse, misap-
plication, abnormal use or a virus.  

DISCLAIMER OF WARRANTIES.  THE LIMITED WARRAN-
TY THAT APPEARS ABOVE IS THE ONLY EXPRESS WAR-
RANTY MADE TO YOU AND IS PROVIDED IN LIEU OF
ANY OTHER EXPRESS WARRANTIES (IF ANY) CREATED
BY ANY DOCUMENTATION OR PACKAGING.  EXCEPT
FOR THE LIMITED WARRANTY AND TO THE MAXIMUM
EXTENT PERMITTED BY APPLICABLE LAW, MICROVI-
SION AND ITS LICENSORS PROVIDE THE LICENSED
SOFTWARE AND SUPPORT SERVICES (IF ANY) “AS IS”
AND WITH ALL FAULTS, AND HEREBY DISCLAIM ALL
OTHER WARRANTIES AND CONDITIONS, EITHER
EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT
NOT LIMITED TO, ANY (IF ANY) IMPLIED WARRANTIES,
DUTIES OR CONDITIONS OF MERCHANTABILITY, OF FIT-
NESS FOR A PARTICULAR PURPOSE, OF ACCURACY OR
COMPLETENESS OR RESPONSES, OF RESULTS, OF WORK-
MANLIKE EFFORT, OF LACK OF VIRUSES AND OF LACK
OF NEGLIGENCE, ALL WITH REGARD TO THE LICENSED
SOFTWARE, AND THE PROVISION OF OR FAILURE TO
PROVIDE SUPPORT SERVICES.  ALSO, THERE IS NO WAR-
RANTY OR CONDITION OF TITLE, NONINFRINGEMENT,
QUIET ENJOYMENT, QUIET POSSESSION, CORRESPON-
DENCE TO DESCRIPTION OR NON-INFRINGEMENT WITH
REGARD TO THE LICENSED SOFTWARE.

EXCLUSION OF CONSEQUENTIAL AND OTHER DAM-
AGES.  TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, NEITHER MICROVISION NOR ITS
LICENSORS WILL BE LIABLE FOR ANY SPECIAL, INCI-
DENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, DAM-
AGES FOR LOSS OF PROFITS OR CONFIDENTIAL OR
OTHER INFORMATION, FOR BUSINESS INTERRUPTION,
FOR PERSONAL INJURY, FOR LOSS OF PRIVACY, FOR
FAILURE TO MEET ANY DUTY INCLUDING OF GOOD
FAITH OR OF REASONABLE CARE, FOR NEGLIGENCE,
AND FOR ANY OTHER PECUNIARY OR OTHER LOSS
WHATSOEVER) ARISING OUT OF OR IN ANY WAY RELAT-
ED TO YOUR USE OF THE FLIC™ SCANNER(S) OR THE
LICENSED SOFTWARE, THE PROVISION OF OR FAILURE
TO PROVIDE SUPPORT SERVICES, OR OTHERWISE UNDER
OR IN CONNECTION WITH THIS AGREEMENT, INCLUD-
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ING AS A RESULT OF A CLAIM OF PATENT, COPYRIGHT
OR TRADEMARK INFRINGEMENT, EVEN IN THE EVENT
OF THE FAULT, TORT (INCLUDING NEGLIGENCE), STRICT
LIABILITY, BREACH OF CONTRACT OR BREACH OF WAR-
RANTY OF MICROVISION OR ANY LICENSOR, AND EVEN
IF MICROVISION OR ANY LICENSOR HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES.

LIMITATION OF LIABILITY AND REMEDIES.
NOTWITHSTANDING ANY DAMAGES THAT YOU MIGHT
INCUR FOR ANY REASON WHATSOEVER (INCLUDING,
WITHOUT LIMITATION, ALL DAMAGES REFERENCED
ABOVE AND ALL DIRECT OR GENERAL DAMAGES), THE
ENTIRE LIABILITY OF MICROVISION AND ANY OF ITS
LICENSORS UNDER ANY PROVISION OF THIS AGREE-
MENT AND YOUR EXCLUSIVE REMEDY FOR ALL OF THE
FOREGOING (EXCEPT FOR ANY REMEDY OF REPAIR OR
REPLACEMENT ELECTED BY MICROVISION WITH
RESPECT TO ANY BREACH OF THE LIMITED WARRANTY)
SHALL BE LIMITED TO THE GREATER OF THE AMOUNT
ACTUALLY PAID BY YOU FOR THE LICENSED SOFTWARE
OR U.S.  $5.00.  THE FOREGOING LIMITATIONS, EXCLU-
SIONS AND DISCLAIMERS (INCLUDING SECTIONS 6, 7,
AND 8 ABOVE) SHALL APPLY TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, EVEN IF ANY REME-
DY FAILS ITS ESSENTIAL PURPOSE.

TERMINATION.  If You breach any provision of this Agreement,
then Microvision may terminate any license granted hereunder
effective immediately without liability after 10 days written notice
to You, and You will promptly return to Microvision all copies of
the Licensed Software.

ASSIGNMENT AND FLIC™ SCANNER(S) TRANSFER.
You may not sublicense or assign this Agreement or any interest or
right granted herein without Microvision’s prior written consent.
The Licensed Software is configured for the sole purpose of oper-
ating with the Flic™ Scanner, and accordingly this Agreement
shall be automatically assigned on the sale or transfer of the Flic™
Scanner with which the Licensed Software operates to the person
or entity who takes title to such Flic™ Scanner, provided that such
assignee or transferee abides by the obligations and restrictions set
forth in this Agreement.

GOVERNMENT LICENSEE.  The Flic™ Scanner and Licensed
Software and accompanying documentation were developed at pri-
vate expense and no part of them is in the public domain.  The
Licensed Software is “Restricted Computer Software” and
“Commercial Computer Software” and if You are acquiring the
Licensed Software for the United States Government, then it is
acquiring only “restricted rights” in the Licensed Software and its
Documentation, all as defined in the applicable provisions of the
Department of Defense Federal Acquisition Regulation

Supplement and the Federal Acquisition Regulations.  Such unit
will include a “restricted rights legend” on the Flic™ Scanner and
Licensed Software as may be necessary to insure the limitation of
rights acquired by the government.  Notwithstanding the foregoing,
this license will not become effective with respect to the United
States Government without Microvision’s prior written approval.

EXPORT CONTROLS.  This Agreement is subject to the laws,
regulations, orders, decrees of the United States which may be
imposed from time to time restricting the import/export of the
Products to/from the United States.  You will not export or re-
export the Licensed Software, or any part of the Licensed Software,
directly or indirectly, prohibited by or in violation of the laws, rules
or regulations of the United States or any applicable jurisdiction.
Nor will You export or re-export the Licensed Software, or any part
of the Licensed Software, directly or indirectly without first obtain-
ing the required permission to do so from the applicable govern-
mental agencies.

COMPLIANCE WITH LICENSES.  If You are a business
organization, You agree that upon request from Microvision or
Microvision’s authorized representative, You will within thirty (30)
days fully document and certify in writing that use of any and all
Licensed Software at the time of the request is in conformity with
Your valid license from Microvision.

MISCELLANEOUS.  This Agreement is governed by the laws of
the State of Washington.  If any term or condition of this
Agreement is or will become invalid or unenforceable, then such
part will be ineffective to the extent of such invalidity only, with-
out affecting this Agreement’s remaining provisions.  The third
party licensors of any part of Licensed Software are third party
beneficiaries hereunder and have the right to enforce the provisions
hereof.  Sections 3, 5, 6, 7, 8, 9, 12 and 13 will survive cancellation
or termination of this Agreement.  The remedies at law of either
party in the event of default or impending default by the other party
in the performance of any terms of this Agreement will not be ade-
quate, and such terms may be specifically enforced by a decree for
specific performance, injunction or other appropriate equitable
relief.  This Agreement is the entire agreement between the parties
with respect to the subject matter set forth herein and supersedes all
prior oral written agreements between the parties with respect
thereto and may only be amended in writing by the parties.  

YOU ACKNOWLEDGE HAVING READ, UNDERSTOOD
AND ACCEPTED THIS AGREEMENT.



Legal Notices

Copyright Notice

Software copyright ©1996-2003 by Data Technologies, Inc. All rights reserved.
Distributed under license with Microvision, Inc.

Changes to Manual

The information in this document is subject to change without notice, and does not rep-
resent a commitment or warranty on the part of Microvision, Inc., or Data Technologies,
Inc. No part of this manual may be reproduced by any means for any purpose without
the express written permission of Microvision, Inc., and Data Technologies, Inc. The sole
exception is that purchasers of the Flicware Pro software may print copies of this docu-
ment for internal use only.

Trademarks

Microvision and the Microvision logo are registered trademarks of Microvision, Inc. Flic,
Flicware, and Flicware Pro are trademarks of Microvision, Inc.

Data Technologies is a trademark of Data Technologies, Incorporated.
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